Leica (GNSS)

CookBook
Lisboa, 25 Fevereiro 2025

Configuracao e medigao com Recetor Leica 1200

a) Gestor (3)
b) Configuragdes (3.5)
a. (novo ou edita) = Estatico 5s
Modo tempo real: nenhum
Antena: AX1202 Pilar
Registo de Observacdes: Estatico
Taxa de registo: 5s
Ocupacdo do ponto: normal
Paragem auto: nao
Controlo de qualidade: nenhum
c) Gestor (3)
d) Trabalho novo (3.1) : (home do grupo)
a. Sistema de coordenadas: ETRS89
Grava
e) Medicao (verificar trabalho e configuracao)
a. Ocupa (15 minutos)
b. Para
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Configuragao e medicao com Recetor CS15

1. Utilizador
2. Guia de Configuragdes
a. Criar uma nova configuracdo/editar/escolher = Estatico 5s
b. Antena moével: GS15 pilar
c. Controlo de qualidade:
i. Desativar: parar automaticamente a medicao
ii. Desativar: verificar a qualidade
iii. desativar
d. Registo de Observacgdes:
i. Registar no recetor
i. Iniciar gravacao: apenas na medicao
iii. ObservacGes: estatico
iv. Tipo de dados: RINEX

v. Taxa:5s
3. Dados
a. Novo Trabalho> inserir nome
b. Gravar

4. Programas
a. Medir > Medir > resposta a pergunta : Nao
b. parar
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Configuracao e medigao com Recetor GS16

1. Criar no Trabalho

Geral: Nome : G1
Coordenadas: PT-TM06 ETRS89
Gravar

2. Definigcées

GNSS: Gravar Observacdes
Recetor, Estaticas, 5s, RINEX versdo 4
Controladora, Estaticas, 5s
Antena: Tipo de antena, altura da antena
Captacdo de satélites: (todos)
3. Medir
ID do ponto
Altura da antena
Medir

Descarregar dados Leica 1200

Computador da sala de topografia
User: \degge
Pwd: Abc123

1. Ligar o receptor com conversos RS323 a USB na porta da frente
(porta superior COM3; porta inferior com4)

2. Software Leica Geooffice
Tools > data Exchange manager
Serial Ports (botdo direito) > Settings
Selecionar leica 1200 nos dois menus
CF-Card > Files > dbx
Copiar todos os ficheiros do projecto (*.m00, *.i00, *.X*)

Descarregar dados Leica GS15 e GS16

Retirar cartdo da antena e copiar os ficheiros para o disco. (ficheiros RNX)
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Dados da estagdao de Referéncia

Coordenadas da estacao de CASCAIS, IGP, FCUL

GRS80/PTTMO06 CASCAIS IGP FCUL

Latitude 38° 41’ 36.28293" 38° 43’ 33.68565 38° 45’ 23.27103
Longitude -9° 25’ 6.68509” -9°9 30.67948 -9°9 24.74894
h (elipsoidal) 77.064 / 76.043 178.862 155.582
H (ortometrica) 23.689 125.538 102.170
M -111831.916 -89170.497 -88989.446
P -107442.112 -104106.957 -100729.238

a) Ver site EUREF (www.epncb.oma.be)

Dados igs.bkg.bund.de/EUREF/obs/ (data Access BKG-EUREF-OBS)

Conversao CRX2RNX -> CASC0830.10d

b) Descarregar os dados com Filezila

Dados DGT: ftp://ftp.igeo.pt - > RENEP -> nome da estagdo (IGP0O, CASC, PALM)

Dados FCUL: ftp://ftp01.fc.ul.pt/gpsdata/

c) Ligacdo direta no Windows

Explorer > This PC > (botdo direito do rato) > add a network location

(inserir endereco: ftp://ftp.igeo.pt)

d) Conversdo de formato RINEX (Se necessario, versdes antigas do Infinity)
Os ficheiros da estacdo IGP estdo no formato Rinex versdo 3.4 que nao é lido pelo
software Leica Infinity. E necessario converter para versdo 2.1

Para converter formato Rinex 3.* para 2.* : https://gps-solutions.com/gnss converter

Para converter formato Rinex 3.* para 2.*: RTKLIB (rtkconv.exe)
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http://www.epncb.oma.be/
ftp://ftp.igeo.pt/
ftp://ftp01.fc.ul.pt/gpsdata/
ftp://ftp.igeo.pt/
https://gps-solutions.com/gnss_converter

Processamento na Web

E possivel processar os dados GPS na web. Indico dois sites.

Trimble

https://www.trimblertx.com

Canada.ca = MNatural Resources Canada = Maps, Tools and Publications = Geodetic Reference Systems > Geodetic tools and data

= Precise Point Positioning

https://natural-resources.canada.ca/maps-tools-and-publications/geodetic-reference-
systems/data/10923
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https://www.trimblertx.com/
https://natural-resources.canada.ca/maps-tools-and-publications/geodetic-reference-systems/data/10923
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Processamento dados GPS no Leica Infinity

Floating License (@fc-licserver.fc.ul.pt)

Passos:

Configuracdo do Leica Infinity
Criar projecto

Importar dados

Analise dos dados

Importagdo para o project
Preparagao do processamento
Processamento

Analise do processamento

. Ajustamento

10. Exportagao

Lo NOULRWNER

1. Configuragao do Leica Infinity

1.1 Sistemas de Coordenadas

> Menu Inicial > Tools

9 Sufsces Scaming lmaging Inkastruchee  Adustments Festurss  Exiemal Services

_.
H

% Manager ¥ impart 1 tocaiee

Coordinate Systems.

BaN1O

Para alterar um sistema existente ou definir um novo sistema de coordenadas

> Manager
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Neste menu podemos criar:

a) um novo modelo de Gedide (geoide Model)
» Importar o modelo de geoide: GeodPT08.gem

b) um novo sistema de coordenadas (Coordinate System)

» Importar o sistema PTTMO6: ficheiro TRFSET.dat
1.2 Criar ou visualiza os parametros das antenas

Os parametros importantes sdo o centro de fase

> Tools > Antenas > Manager

Leiea Infiity

CO— e o

¥ Type ¥ Colibration Dste | Souce | GPS Y GLONASS ¥ Galieo ¥ | Beidou ¥ | M

b Geoe- GmbH Relative

b Leica Absciute
Help & Suppart

b Leica Relative
: b NGS 14 Absolute
(U b HGS Abssiute
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Parametros da antena LEIGS15

%]

Preferences

Code Tables

Targets

Anterinas

Geareferenced Imal

|!‘ L @ /‘I\i‘ 0 h A ? = * Satelite | Edit
cootespen] gt o opyio Dowroed. e New
P Antennas/Caibration Sets
KGSNome ¥ | Radome ¥ Type | Collration Dete | Source | GPS ¥ GLOMASS Y | Gaeo V¥ Beic

LEIAR20 | Elevation @ o

ety cation - @ v 1GS Narme LEGS15

LElc80 rabon @ un

LEWR25 A3 Elevation [~

LEIGMXS01PLUS @ un

LRz R o ez Calbration Set Leica Abschte

LEIcGe0 rabon @ un i

LEIATX12306G cation [~ -
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LEIGs1S Elevation o une o ol

LEIGS18 Elevation @ un P —

LEIAK12026G Elevation [~

LEWR2S R4 scrr Elevation @ v

LER10 Elevation [~]

LEiGS08 Elevation [~]

LEIGS14 [~]

LElass [~]

LEIATX1230+GNSS [~]

LEWATSO [~]

LEIGG0 Elevation [~]

Leiea Infiity

Imaging  Infrastructure Adjustments  Festures  Exter

3 Manager | [ ® import | [ # Expont

Antennas / Calibration Sets

GNSS Manager

Parametros da antena LEIAX 1202

Tools

o
T
%
b

Preferences

Help B Support

et

g Surbsces ing

Code Tables

Torgets

Antennas

Coardinate System

Geareferenced Im

Leica Infinity

Imaging  Infr

tments  Festures  External Sery

& Manager [ #mpore | [ % Eon |
Antennas / Calibration Sets
GNSS Manager
EN— | o=ty o
1G5 Name. Radome T Calibeation Date | Source | GPS ¥ GLONASS V| Golleo ¥ Beic & Leica Absolute -
LEIAR25 A3 - B v 4 Antenna
LEIGMXO01PLUS Elevation - Rt 1G5 Name LEIATS04
LEIAR2S R4 Elevation Qv Radome
LENCGE0 Elevation O e N
LEIATX1230GG Elevation 8 v 4 Calibration
LEIATS04GG LEis Elevation B uw Calibration Set Leica Absolute
LEIGSTS Elevation B uw Calibration Date
LEGS 16 Flevation [~ T e =
LEAXT, Elevation | ue e Elevation
LEIAR25 RA s Elevation B ue [r—" g
LEIARTD Elevation [~ I P —— o
LEIGS08 Elevation w2
@ S )
LEGS14 Elevation o v
System GPs -
LEASOS Elevation B ou
Frequency [t -
LEATX1230 Elevation [ JESTE
Nerth 00000 m
LEIATS04 Elevation G ue
[ 00000 m
LEIGGD4 Elevatian 2
a Up 01177 m
LEIAR2D LEm Elevatian [ JRTE
LEIGS18 Elevation B v
LEIATS04 LES Elevation %]
=
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2. Criar um novo Projecto (New Project)

> File > New project >

Leica Infinity - a x

4 Project Details
Project Name aw Project

Project Owner

Skype

Wabsite

4 Storage
Project Location HaWricatalaoaulas\Projecto EGYGPS L =
Create Project Subfoider |7 GRS 1980
+ Feature Coding Projection #1-Thit6
Code Table None ~  Projection Type Transwerse Mercator
Geaid Mode GeodPTOE
€505 Mode!

4 Coordinate Display
Output cal and WG58

WGSEA Geodetic
WGS584 Cartesian

Switch Easting

Preencher:

Project Name + Storage

Units

Coordinate System: PT-TMO6 Etrs89
Coordinate Display (Local Grid + Local Geodetic)

3. Trabalhar num projecto existente

> File > Project manager > escolher o projecto > Load

4. Importar dados (Import)

> Home > Import
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Ceordirate

Compute
Project Coambrates Sytem Mansger
Coordinates

[l Property Grid 33 Creste bew Paint 53

PROI1B-0020
(s or PROJS-0020

PRONE-0029

164K

010372018 114854

Selecionar os ficheiros que se pretendem processar. Ter em atencdo que os ficheiros
extraidos do recetor Leica estdo (geralmente) em formato “Leica” (MDB) e os ficheiros da
estacdo de referencia estdo em formato RINEX. Para que todos os ficheiros surjam na
listagem devera selecionar-se a opcao “All raw data types”

Os ficheiros da estacdo de referencia deverdo abranger na totalidade o periodo de
medi¢do dos pontos a coordenar.

Para visualizagdo da barra do tempo e propriedades dos dados devera ser acionado o
“inspector” botdo na barra inferior

Seleccionar “Merge Intervals”

5. Processar os dados (Processing)

Sobre o nome do ponto referencia selecionar na barra superior “reference”. No painel do
lado direito definir “Point Role” Control e alterar as coordenadas do ponto. No final fazer

”Apply”

Alterar o estado dos pontos a coordenar para “Rover” e “Point Role” para Navigated.
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Verificar os parametros de processamento em “Strategy”

B @ GTE» . 2018_61 - Lewca Infinity

P LekaBelstve  + FRover  FgCleardl
E seore AR Reference [T Clear Window
B Raport

PR . o . . : 01008
T, Pot e 7| Flesowee ¥| st T e T
e Nevgsied | PRI OVIRGOIE N4 OVIREONE 1
= w102 w1sa0ns 164 Mavgsied - PROIE-0029 L]
1108 w1ETE a4n Mevguied  FROI1S-0029 L]
T Nevgied  FROI1S-0029 ]
Contro 1540060 [

LEICA GX1230
45

“ Source

+ W PRone00ze P
v W igpo0s0i @

Processing Strategy

Solution Type Phase fived
Solution Optimsation  Automatic

Tropaspheric Modsl | VMF with GFT2 model

@
0103/2018 113127

lonaspheric Madel  Automatic -

Stardard Devistion =
23927 m
21607 m

Importar as orbitas precisas (GNSS Manager, Precise Ephemeris, Download)

[~ FoTn X, ortega - Leica nfiniy -
Processing
P Leica Relative ~ * 7. Rover T Clear All Selections ] Data & H.' ) A y 5 / \f 1 Al i Remove Adjustment
& stare A\ Reference [ Clear Window 4 strategy = e - ‘1 - Ll ‘e £} /‘j - = Add TP 1o Library
i Remove Processing 579 B Report -« & Advanced Level Line Obsenvation
=
Q Q B 240042018 141859 -
4 Library 9 = 4 GNSS Processing Result
Py - o 3 4 Catelite  Edit Ed Time ] Home 2470472018 141859
5] GPS0001 (21/03/2018 12:4902) d = /2018 12:4ff DateTime 24/04/2018 14:18:59
=] GPSO0D2 (21/03/2018 13:1732) = 2018 13: ff Points and Baselines 7

| GPS0003 (21/03/2018 133627)
=| GPSO004 (21/03/2018 13:53:12)
& GPS0005 (21/03/2018 14:08:37)

/2018 13
Dawnload 2018 13

T Preias Epher

; - Dae Y ‘Satelite System V| Satelites ¥ Y2018 144
E:;T;:x:?;::;‘m B 2vooroons | crveioAsy o cdouzss 2 o, coa ] St Date 21032018 105942 ]
F 20/03/2018 | GPS/GLONASS/Gallen/Beidou/ZSS w2 aor, oz fff nd Date 2110372018 145937 alp?
19/03/2018 | GPS/GL 82 GD1 GOz i Precise Ephemeris
Navigaton Fie
Path ojecta -
e
Name Y Smws Y Progeess
4 Source CODOMGHFIN 20180790000 01D 05M ORBSPlgz  Imported
+ [ DefoultlobName 052¢ = CODOMGHFIN 20180800000 D10 0SM ORBSPig:  Imported
4 [ DefoultiobName-0524 o GXFIN 2018081 il L imported

Cancel

Para processar os dados fazer: “Process”
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urfaces  Scanning  kmaging  Infrastructure  Adjustments  Features  External Services

& TlecaRelstve 7 fover T Clesr AlSelections [ Data \% Ay . i 4 Remove Adjustment
GNSS

i & store F. Reterence () Gew Window i srategy S, 3 s 5 . = : / o AdaTPw Ly
Process = Point  Ssbon Obmenvation Travese  Ses Foresights | Ads e
b e B eper * 8 ddarced piansger Leveitine " Ovceraten

Neste caso os pontos PTO1 e PT0O4 tém avisos. Antes de guardar o resultado em “Store” os
avisos deverdo ser corrigidos. Se ndo for possivel corrigir os avisos os pontos deverao ser
eliminados. Neste caso o ponto 4 foi observado de baixo de arvores e por isso ndo tem o
numero minimo de observagdes para se poder calcular a coordenada com a qualidade
exigivel num posicionamento estatico.

No final os pontos devem ser guardados: “Store” (botao direito do rato)

6. Resultados (Results)
Analisar os resultados: “Report”

Exportar os resultados: Home > Export > escolher o formato e o nome do ficheiro.

Ver relatdrio para identificar os satélites usados no calculo
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